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ExpressMaintenance Tech Bulletin 

Using Report Builder RAP 
 
 
ExpressMaintenance includes the top rated reporting tool, Report Builder.  Using SQL within Report Builder, users can produce 
comprehensive reports presenting data in just about any desired format.   Reports often need to include calculated fields as well as 
advanced calculations based on logical conditions.  Report Builder includes a powerful but advanced language for this purpose. 
 
Report Application Pascal, RAP allows users to create their own calculations within reports.   RAP extends Report Builder by giving 
end users the ability to code their own event handlers and extended calculations. The Calc workspace is an Object Pascal 
development environment that is designed for ease of use by non-developers. The Code Explorer offers varied views of the report 
code module; the Code Editor is a syntax-sensitive Pascal editor; the Code Toolbox serves double duty, providing both a partial list 
of supported identifiers as well as a drag & drop code creation facility. 
  
To utilize the RAP capabilities of Report Builder, you must: 
1. Download and install the very latest release of ExpressMaintenance.  Rap was made available starting in version 5.5.1.2. 
2. Turn on the feature under Utilities / Set Application Properties / Enable RAP Interface. 
3. View the ExpressMaintenance Application Help including the Report Builder / RAP Interface topic for complete details on the 

RAP aspect of Report Builder. 
4. Download the pdf documentation - What is RAP from our website. 
5. Download the pdf documentation - Learning RAP from our website. 
6. Consider downloading and working through the Report Builder learning tool from our website. 
 
 
The pages that follow provide an explanation of the use of the RAP language feature of Report Builder.  The explanations follow the 
example report “PM Services Analysis Report” which is available from our website at  
http://www.expresstechnology.com/DownloadReports.htm. 
 
It is recommended that users download the “PM Services Analysis Report” and view the various examples as they read this bulletin.  
The RAP language allows for advanced logic and calculations that will handle almost any desired reporting needs. 
 
The Report Case 
The user desires a report that shows all scheduled work order services that are preventative maintenance (PMs).  They desire that the 
report list the PMs along with the work order number, unit name, scheduled date, performed date and other pertinent information.  In 
addition, the user wants some unique information based on calculations and based on logic that is unique to that user. 
 
The users has a policy that PMs must be completed within a certain number of days (deadline days).  The number of days depends on 
the scheduling period of the original PM as shown below. 
 
Daily PMs 1 day from scheduled date 
Weekly PMs 1 day from scheduled date 
Monthly PMs 7 days from scheduled date 
Quarterly PMs 14 days from scheduled date 
Bi-Annual PMs 30 days from scheduled date 
Yearly PMs 30 days from scheduled date 
 
The user desires for the report to reflect the number of days allowed for the completion of the PMs as well as the number of days that 
it actually took to complete the PM.  If the PM has not been completed, the report should reflect the number of days from the 
scheduled date to the current date in order to reflect the days that have lapsed from the scheduled date.  In other words, the report 
should reflect completed and non-completed PMs and show the performance in comparison to the deadline days outlined above. 
 
The pages that follow provide information on how this report was developed.  Not every step is included but rather the primary steps 
associated with the use of the RAP features of Report Builder. 
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Good Report design involves some careful thought before beginning.  The following questions should be answered before you start. 
1. What data do I want to extract?   
2. Is the data coming from work orders or what tables? 
3. What will be the selection (search criteria)? 
4. How do I want the data to be sorted? 
5. How do I want to organize and present the data? 
6. What variables and calculations will need to be performed? 
 
The first step is to open the Maintenance / Reports screen and click on the Report Designer button and begin a new report. 
 
 
 
 
 
 
 
Once the Report Designer is open, click on the Data tab to start defining what data is to be extracted, what search criteria will be 
used and how the data is to be sorted. 
 
Since the report is based on work order services we know we will be using the WoMaster and WoServices tables.  So we click on 
File / New / Query Designer.  In the Query Designer we click on different tabs and select different information.  In this case we 
select the following: 
 
Tables   Fields   Sort  Search 
WoMaster  Scheduled Date  Completed ScheduledDate Between 01/01/2007,01/31/2007 (example) 
WoServices  Completed Date  Number 
   Performed  Description 
   Numbered 
   Unit 
   Unit Name 
   Completed 
   Description (service name) 
 
Since this is not an aggregate query, we do not enter anything in the Group tab.  To give the Query a more user friendly name, we 
click on the SQL tab and name the Query WorkOrders. 
 
We do need to create some calculated fields so we let SQL do the work for us and create two calculated fields under the Calc tab as 
shown below.  Using the SQL DateDiff command this becomes easy work.  We use the expression to create the calculated fields: 
DaysTaken - The difference between the Scheduled date and the Performed date (for completed services). 
DaysPasted - The difference between the Scheduled date and the current date (for non-completed services). 
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The resulting Query looks like the following on the Data tab.   
 
In addition to performing a query of the work order services, we must 
also obtain some additional information.  Once services are created in 
the work order, they are no longer directly tied to the PM and the work 
order does not know about the actual scheduling information such as 
the Period and Interval.  The work order data just tells us that the 
service is scheduled on a work order. 
 
However, since the user has some logic to apply to the report based on 
the original schedule of the PM, we must link the work order service 
back to the original PM and get the scheduled Period (weekly, 
monthly, etc). 
 
To do this, we create another query by clicking File / New / Query 
Designer and selecting the following: 
 
Tables 
Units - To link to the work order. 
Servitem - To link to the service.  This table contains the PMs for the 
units (equipment).  Later you will learn how the linking is done. 
 
Fields 
Units.RecordNumber (to join with Unit field of the work order query) 
Service - The name of the service. 
Period (weekly, monthly, etc. 
Interval (number of the periods) 
 
Sort 
RecordNumber 
Service 
 
Finally, we can click on the SQL tab and give the query a more user friendly name such as Units. When both query windows are 
complete they appear as shown below in the data tab. 
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Joining The Queries 
Next we must define the join between the two queries.  This can be done graphically on the Data tab by dragging the mouse between 
the join fields of the two query windows.  However, the graphical method is not practical if you are to join more than one field in the 
query or one of the queries is an aggregate query.  In this case, we need to join the two queries by the unit and the service so we will 
use the manual method to create the join. 
 
To do this we click on the Calc tab and then click on the Report object in the upper left corner of the tree.   
Next we click on the BeforeOpenDataPipelines event and type the AddLink command for the joins as shown below 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This causes the Units query to link to the WorkOrders query by joining the Units.RecordNumber field with the WorkOrders.Unit 
field and the Units.Service field with the WorkOrders.Description field. 
 
The report is based on the WorkOrders query and as each record is read in the WorkOrders query the program will position to the 
correct unit and service in the Units query.  This is why we set the sort of the Units query by RecordNumber and Service. 
 
The purpose of this document is not to fully explain joins and table relationships but rather the RAP language.  There is additional 
information on how tables join on  the ExpressTechnology.com website.  In addition, if you have questions about how tables or 
queries should join, send us an email at support@ExpressTechnolgoy.com. 
 
Report Design 
Now we are ready to begin the actual design of the report.  Click on the Design tab of the Report Builder. 
 
This begins with  placing label components for the headings and DBText components for the data fields on the report as desired.  
You can use the report wizard to get these placed on the design screen for you.  Click on File / New / Report Wizard and follow the 
steps of the wizard. This will not get the report exactly as you want ibut it will save you a lot of time placing labels and DBText 
components on the screen. 
 
In this example, we also set the report to Landscape by selecting File / Page Setup / Paper Size.  This is best since we have a lot of 
data to display. 
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In addition, we will place Variable components on the design page for which we will soon attach code.  The variable components 
should be set to a type of Double for numeric values. 
 
The following is a screen shot of the design tab after we have all of our components placed on the screen.  You will notice that there 
are several variable components on the screen.  Explanations and examples of the calculation code on the variables will follow. 

 
The final report will appear as shown below: 

Notice that the report includes the calculation of the Days Allowed, Days Taken, Over / Under as well as several calculations at the 
bottom.  The following pages will explain the code on each of the variable components.  Variable components in Report Builder are 
used as triggers to perform certain calculations and logic at certain points in the report as it iterates through the data. 
 
You will notice that variable components exist in the Detail band as well as the Summary band of the report.  When a variable is 
placed on the design part of the report, you must select the type of variable (string, double, currency, etc).  You should also set the 
Visible property.  Some variables are used for coding logic and are not actually intended to be visible.   If the variable is a number 
(double), you should right click on the variable and set the Display Format as well. 
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The following is a list of the variable components used and an explanation of each. 
Variable1 - Days Allowed, the number of days based on the period / interval of the PM. 
Variable2 - Days Taken, the number of days between the scheduled date and the performed date or the scheduled date and the system 
date if not yet performed. 
Variable3 - Over / Under Days, the difference between Days Allowed (variable1) and Days Taken (variable2). 
Variable4 - Total Services, a simple count of the number of services in the report. 
Variable5 - On Time, a count of the number of services within the days allowed. 
Variable6 - Not On Time, a count of the number of services not within the days allowed. 
Variable7 - Percent On Time, the percent of services within the days allowed. 
Variable8 - Percent Not On Time, the percent of services not within the days allowed. 
Variable9 - Completed Services, a count of the number of completed services. 
Variable10 - Non-Completed Services, a count of the number of non-completed services. 
Variable11 - Average Days To Complete, the average number of days to complete services that are Completed. 
Variable12 - Total Completion Days, the sum of all days used on completed services, used in the calculation of variable11. 
 
To access the calculations code, right click on the variable and select Calculations.  You can also access the code under the Calc tab 
by locating the Variable component and selecting the OnCalc event. 
 
Variable1 - Days Allowed, the number of days based on the period / interval of the PM. 

The code above evaluates the Period of the original PM and determines the number of days allowed (see page 1).  Notice that we use 
monthly interval to determine which PMs are quarterly and bi-annual.  If the Period is Monthly and the Interval is less than 3 
(monthly) then the value is 7.  If the Period is Monthly and the Interval is less than 6 (quarterly) then the value is 14.  If the period is 
Period is Monthly and the Interval is greater than 6 (Bi-Annually) then the value is 30.  You can adjust the values as desired or 
change the logic as desired for your application. 
 
By using this simple logic we set the value of the Days Allowed (variable1).  
 
The language used is actually rapid  object pascal (RAP) and very simple.  You will notice the use of begin / end and that all 
statements must end with a semi-colon.   To learn more about the RAP language, visit our website and click on the Tech Bulletins 
link and go to the Reporting section.  You will find resources there for learning more about the RAP language as well as a Report 
Builder tutorial. 
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Variable2 - Days Taken, the number of days between the scheduled date and the performed date or the scheduled date and the system 
date if not yet performed. 
 

The code for above variable2 determines which value to report under the Days Taken column.  You may remember that in our SQL 
expression of the Data Query, we performed two calculations. 
DaysTaken - The difference between the scheduled date and the performed date. 
DaysPasted - The difference between the scheduled date and the system date (current date). 
 
If the service has not yet been performed, we place the DaysPasted in variable2 (DaysTaken).  If the service has been performed, we 
place the value of DaysTaken in variable2. 
 
Variable3 - Over / Under Days, the difference between Days Allowed (variable1) and Days Taken (variable2). 

The code above for variable 3 does several things.  The first line simply subtracts the value of DaysAllowed (variable1) from the 
value of DaysTaken (variable2) to determine the over / under days. 
 
Since this variable’s oncalc event fires on each record, we also perform several other calculations that will be used in the summary 
section of the report. 
 
The second line of code simply increments the value of variable4 by one.  Variable4 is the count of all services in the report. 
In lines 3 through 6 we assign counts of services not on-time and on-time.  If the over / under value is less than or equal to 0 it adds 
one to the number of services on time counter (variable5) and if the service is not on-time it adds one to that counter (variable6). 
 
In lines 7 through 15 we test to see if the service has been performed.  If the service has been performed, the code then: 
Adds one to variable10 which is the count of completed services. 
Adds the days taken to variable12 which keeps a total of the days taken on completed services. 
 
Finally, if the service has not been performed, the code adds 1 to variable9 which contains the count of services not completed.  
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Variable4 - Total Services, a simple count of the number of services in the report. 
This variable does not have any calculations attached to it as the value was assigned during the oncalc event of variable3. 
 
Variable5 - On Time, a count of the number of services within the days allowed. 
This variable does not have any calculations attached to it as the value was assigned during the oncalc event of variable3. 
 
Variable6 - Not On Time, a count of the number of services not within the days allowed. 
This variable does not have any calculations attached to it as the value was assigned during the oncalc event of variable3. 
 
Variable7 - Percent On Time, the percent of services within the days allowed. 

The code on variable7 calculates percent of services that are on-time regardless if they have been completed.  It simply divides the 
on-time count (variable5) by the total number of services (variable4). 
 
Variable8 - Percent Not On Time, the percent of services not within the days allowed. 

The code on variable8 calculates percent of services that are not on-time regardless if they have been completed.  It simply divides 
the not on-time count (variable6) by the total number of services (variable4). 
 
Variable9 - Completed Services, a count of the number of completed services. 
This variable does not have any calculations attached to it as the value was assigned during the oncalc event of variable3. 
 
Variable10 - Non-Completed Services, a count of the number of non-completed services. 
This variable does not have any calculations attached to it as the value was assigned during the oncalc event of variable3. 
 
Variable11 - Average Days To Complete, the average number of days to complete services that are Completed. 

The code on variable 9 calculates the average days to complete for the completed services.  It uses the total days to complete 
(varible12 and divides it by the number of completed services (variable10). 
 
Variable12 - Total Completion Days, the sum of all days used on completed services, used in the calculation of variable11. 
This variable does not have any calculations attached to it as the value was assigned during the oncalc event of variable3.  You will 
also notice that variable 12 does not display in the preview. This is because variable12 has the Visible property unchecked. 
 
These are all of the variables used in the report.  As you can see the code is pretty simple once you know what you want to 
accomplish and calculate.  Following are a few notes about variables that should be mentioned. 
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Variable Component Notes 
1. To set variable and other component properties use the Report Tree.  To turn on the Report Tree click on View / Toolbars / 

Report Tree. 
2. Calculations in ReportBuilder are best performed primarily using the Variable components.  It is not recommend that you use 

the band events such as BeforePrint as they often fire multiple times. 
3. Remember to set the variable type such as currency, string, date, etc. 
4. Code the calculations using the Variable.OnCalc event.  You can right click on the variable and left click on Calculations.  You 

can also locate the variable’s oncalc event under the Calcs tab. 
5. Use the Timing dialog to control the timing of the OnCalc event.  To access the Timing dialog, right click over the Variable 

component and select the Timing option from the speed menu.  This allows you to determine the point in which variables are 
cleared. 

6. Set the LookAhead property to True, when you need to display summary calculations in the title, header, group header, etc. 
7. To perform calculations based on the results of other calculations use the Calc Order dialog of the band. To access the Calc 

Order dialog, right click over the Band component and select the Calc Order option from the speed menu. 
8. You can set the Visible property to false to use a variable but not display it’s value. 
9. You can name variables from their default of variableX  to a more recognizable name.  Simply change the UserName property. 
 
The final report appears as shown below. 

 
As you can see Report Builder offers very powerful features through RAP and the use of Variables and Events.  To learn more about 
Report Builder and Rap, visit the Tech Bulletins on our website at www.ExpressTechnology.com.  The tech bulletins include pdf file 
downloads as well as a complete tutorial for learning Report Builder. 
 
 
 
 
 


